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Visual Import Manager

The Visual Import Manager

The Visual Import Manager is an external application that allows the contents of a user’s existing Microsoft
Access database into a new SIMMS database. Use of this program allows inventory details such as item details,
categories, locations and relative accounting information to be easily pulled into a SIMMS company file.

Creating a New SIMMS Database

Log into the SI_ABC database in SIMMS. New Company [Z]
Access Administration menu>Company Manager.
Company Code:; II |im|:u:urt [max 20 characters)
In on the right sidebar, click New Company,
e From Bankupﬁ o Save " o Cloze "
Enter a name for the new company, then click the
Save button.
Operation Information |:|
Click Next on each of the subsequent progress
screens. Databaze created

409 T otal D perations
409 Operationz Completed

Click the CI butt th ini
ick the Close button on the remaining screens 0 Operation Failed

to complete the database creation.
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Visual Import Manager

Setting the Read Permission in the Options
Access Database - - -
Pages ] Advanced ] International ] Speliing ] Tables/Queties ]
Wigw ] General ] Edit/Find ] Keyboard I Datasheet ] Forms/Reparts I

Open the Access Database.

Access Tools>Options>View tab. v gt [ Hidden abjects

[v Startup Task Pane |v System objecks
Select the System Objects checkbox, then click W' Mew object shortcuts W' tiindgws in Taskbar
the Apply button, then the OK button. Shaw in Macro Design

[ Mames column | Conditions column

Click options in database window
" Single-click open
{* Double-click open

Fa o

User and Group Permissions

Pemizzians | Change Owher ]

Now access the Tools menu>Security>User and

Group Permissions tab. Iseraroup Mame: Object Mame:
] Bdrnin i | <Mew Tables/Queties = e
Choose Object Type: Table Films —
Choose Object Name: MSysObijects M3ysaccessObjects
MaysaccessxML
Maysi_Es
MSysCbjects ]
MSysOUeties lndl
Lisk: * Users © Groups Object Type: | Table -
Permissions
Select the Administer cheqkbox (which will select — ¥ Read Data
all the checkboxes). Now click the Apply button, _
and finally the OK button. v Read Design V' Update Data
[v Maodify Design [v Insert Data
v Adminiskter |v [Celete Dakta

Current User: | Admin

k. | Cancel
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Connecting to the SIMMS Database
Open the SIMMS Import program.

Access the File menu>Connect to SIMMS
Database selection.

Enter the Server name where the SIMMS
database resides.

Enter the username/password required for the
connection or select the Use Windows NT
Authorization checkbox.

Click the Connect button.

If properly done, the following message will
appear:

Visual Import Manager

S5imms Imporkt

Fil= Import Daka

Conneck ko SIMMS Database
Conneckt To Access

Close Access Conneckion i
Close Simms Conneckion

E:ikt

M5 Access

Connection State Dizconnected

D atabaze Mame

Sql Server Connection

X,

ServerName  |SUPFORTASUFFORT  ( Comnset

Login M ame |

Paszword |

v Use Windaws NT Authentification

D atabaze Mame |

j Select

—

Information

L]
1 ) Conneckion Succeeded!

Click the OK button.
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Visual Import Manager

Sql Server Connection |:|
ServerMame  |SUPFORTASUPPORT Copnect
From the Database Name dropdown box, select Lagin Name |
the database (your new database) to which you
wish to import the data. Password |
v Usze windows NT Authentification
Click the Select button, then click Close.
1 e Y
Database Mame |§5| impart j Select
( Cloze )
Simms Impork |:|
o ] File Import Data
The connection is confirmed.
Sql Server
Connection State Connected
Server Mame QQEPDHT"-.SLIF'F'
D atabaze Mame S1_impart
k5 Access
Connection State Dizconnected
D atabaze Mame
Connecting to the Access Database Simms Import
, i Import Daka
Access File menu>Connect to Access. File E
Conneck ko SIMMS Database
—_onneck To Access
Close Access Conneckion
Close Simms Connection sLPF
Exik
M5 Access
Connection State Dizconnected
D atabase Mame
Version 3.3 6 September 2, 2005
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Visual Import Manager

Open
Laok jn: | = IMPORT ROUTINE R =l
Select the Access database (MDB file) from which L.qﬁ
you wish to import data. Mg Pecent
Documents
Click the Open button. 9
Deskiop

“Will's Diocuments

39

ey Computer
e R ,
M}'Pfl*laect;\'sork File name: JFlIms.mdb _VJ Open
Files of tupe: JAccess files [*.mdb) LJ Cancel
Simms Impork |:|
File Import Data
Sql Server
Connection State Connected
Server Mame QQEPDHT"-.SLIF'F'
o ] Databaze Mame S1_import
The connection is confirmed.
M5 Access
Connection State Connected
[ atabaze Mame C:5Documents and
Settingzhwill SUPPORT D eskta
=V RADODT OO TIKMCY Cilen s rn Al
Click the Import Data menu.
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Visual Import Manager

Import Options Screen

Under Access Tables dropdown you can select
the tables from which you will be selecting the
data.

From the Import into SIMMS Tables dropdown, e =
select the SIMMS table for the initial set of fields. ;__.z-_-.'r_;#-__:i R et =
s Fomsia e
AR - T = =
| e E‘} " oo e Lergn Urisoe el
o0t 1 s 12 L e Teu
ﬁf # i e e D = .
o Capmw Doate A ] e -
e () Fient Comenara ﬂ e b
RATIHES [t g (= wap -
e Cpolim—
P dpcwwd 3 (] e
] k) o L] sl
J
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Affiliating Access Fields to SIMMS
Fields

Select a field in the left panel (from the Access
database).

Click the cursor into the respective Access Field
column in the right panel.

Click the Right Arrow button to create the
affiliation.

Repeat this for all rows within the Access Fields
column in the right panel.

Once complete, click the Import button to bring
the data into the SIMMS ltems table.

The new Apparel tab gives you the ability to
import apparel information, style code and
descriptions, color code and descriptions, size
code and descriptions, as well as matrix info for a
specified style what color and size combinations
are. Import of apparel assigned styles for
inventory items also exists as a new feature.

In order to assure a smooth trouble free import you must import data into Access not link (you cannot link data from an

Visual Import Manager

The table fields for both the Access and SIMMS databases will now

show.
Import Options |:|
Access Tables
IFi\ms vl Impart into Simms T able: ltems v f|mpan \
Table Fields
CATEEQRT ) Simms Table Fields
FILM TITLE S
BELEASE YEAR Access Field | Simmsz Field ‘ Type | Length | Unique | Mullable
CODE1 Itern_code string a0 yes no
EgtDE 2 FILM TITLE Item_desciiption stiing EO yes no
cost CATEGORY Categomny string a0 ho no
piice unit Ukd stiing a0 no no
location RELEASE YEAR UFC string 50 yes yes
stocked . . p
BATING price Price decimal 0 no yes
LOC cost Cost decimal 0 ho yes
COUNTRY RATING Extended Description  sting 1000 no yes
» COUMTRY Motes string 4000 no yes
Table: item_type SQL Commands &
Table: urit SOL Commands:1
Tablesitems S0OL Commands:13

outside source). We advise creating one access database with a table for Customers (see customer data required in the
tables below), Vendors (see vendor data required in the tables below), Locations (see location data required in the tables
below), Items (see Item data required in the tables below), Stock (see stock data required in the tables below), Quotes

(see quote data required in the tables below).

The structure of the tables are encouraged to be as follows:

Index of terms:  Term Description
Type Data type

Length  allowed length for data in this field
Unique if yes, then the data in this field has to be unique
Nullable if yes, then this field can be left blank

Version 3.3

9

© 2005 by Kornyk Computer Solutions International. All rights reserved.

September 2, 2005



Visual Import Manager

and the fields for direct import into the respective tables:

Customers

Field Name Type Length  Unique Nullable Additional field information

Description string 50 vyes no Customer description

Address string 200 no yes Customer Address

City string 40 no yes Customer City

State string 3 no yes Customer State Code

Zip string 10 no yes Customer Zip Code

E-mail string 100 no yes Customer e-mail address

Phone1 string 20 no yes Customer Phone number

Phone2 string 20 no yes Customer Secondary Phone number

Fax string 20 no yes Customer Fax number

Website string 100 no yes Customer Website address

Comment string 200 no yes Customer Additional comment information

Credit Limit decimal 0 no yes Customer Credit Limit

User defined 1 string 50 no yes Additional user defined 1 information

User defined 2 string 50 no yes Additional user defined 2 information

User defined 3 string 50 no yes Additional user defined 3 information

Vendors

Field Name Type Length Unique Nullable Additional field information

Description string 50 vyes no Vendor description

Address string 200 no yes Vendor Address

City string 40 no yes Vendor City

State string 3 no yes Vendor State Code

Zip string 10 no yes Vendor Zip Code

E-mail string 100 no yes Vendor e-mail address

Phone1 string 20 no yes Vendor Phone number

Phone2 string 20 no yes Vendor Secondary Phone number

Fax string 20 no yes Vendor Fax number

Website string 100 no yes Vendor Website address

Comment String 200 No Yes Vendor Additional comment information

Credit Limit decimal 0 no yes Vendor Credit Limit

User defined 1 string 50 no yes Additional user defined 1 information

User defined 2 string 50 no yes Additional user defined 2 information

User defined 3 string 50 no yes Additional user defined 3 information
Version 3.3 10 September 2, 2005
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Visual Import Manager

Locations

Field Name Type Length Unique Nullable Additional field information

Because a location code contains both the
warehouse and bin code the Location Code

Description String 50Yes No data imported must have both bin and
warehouse code in the data for example for a
bin of 00001 and warehouse code of 999 the
data in this field would be 999-00001

Items

Field Name Type Length  Unique Nullable Additional field information

Iltem_code string 30 vyes no Item Code

Iltem_description string 60 no yes Item Description

Category string 50 no yes Iltem Category

UM string 50 no yes Standard Unit of Measurement

UPC string 50 no yes UPC Code

Price decimal 0 no yes Default Sales Price

Cost decimal 0 no yes Default Cost

Extended Description string 1000 no yes Extended Item Description

Notes string 4000 no yes Additional Item Notes

Cost Additional

Currency string 4 no yes Item Cost Currency

Price Additional

Currency string 4 no yes Iltem Sales Price Currency
Default location code - Note: Because a
location code contains both the
warehouse and bin code, the Location

Default/Reorder Code data imported must have both bin

Location and warehouse code in the data for
example for a bin of 00001 and
warehouse code of 999 the data in this

string 50 no yes field would be 999-00001.

Reorder Point integer 0 no yes Iltem Reorder point

Order Quantity integer 0 no yes Default Automatic reorder Quantity

Minimum Order

Quantity integer 0 no yes Minimum reorder Quantity

Maximum On Hand integer 0 no yes Maximum on hand limit
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Visual Import Manager

Stock
Field Name Type Length Unique Nullable Additional field information
ltem_code string 30no no Item code

Since a location code contains both the
warehouse and bin code the Location Code
data imported must have both bin and

Location String 50No No warehouse code in the data for example for a
bin of 00001 and warehouse code of 999 the
data in this field would be 999-00001.

OnHand decimal Ono no OnHand qty
Manufacturer Lot string 20no yes Manufacturer Lot associated to qty.
Quotes
Field Name Type Length Unique Nullable Additional field information
Quote Number decimal 0 yes no Quote Number
Customer string 50 no yes Customer
Quote Date datetime 10 no yes Date of Quote
Available Date datetime 10 no yes Quote expiration date
Header Comment string 1000 no yes additional header comment information
Final Comment string 1000 no yes additional footer comment information
Item Code string 60 no yes item code
Quantity decimal 0 no yes quantity
UM string 50 no yes unit of measurement
Price decimal 0 no yes Quoted Sales Price
Iltem Comment string 1000 no yes Additional line item Comment

For the other tables listed under the Import into SIMMS Table dropdown box, repeat the above procedure.

NOTE: Users may affiliate the contents of all tables and then click the Import button once, or may do the Import on a per-
table basis.

Once having completed importing the data desired, close the Import screens.

5] Login to SIMS 3.1 ==

Username:  |adrin

Password- |~

Log into the SIMMS database that received the

imported data to begin using SIMMS. Company: |Gl impott | ~|
DB Connection Restore Campan

Copyright: ©2004 Kok Computer Solutions Intermational
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Help Menu

About

The About feature provides links and information
about SIMMS and KCSI.

License Agreement

The End User License Agreement for the
application can be found here.

Register

Using the Activation Code provided by KCSI,

users can come here to register their copy of the

Visual Importer application.

About SIMMS Material Requisition Manager

Visual Import Manager

Product¥ersion: 3.1

@ SIMMS 5oftware. M aterial R equisition Manager Wizt KCSI ot the World ‘wide 'Web

Copyright 2004 Kornyk Computer 5 olutions International. Inc._ All nights reserved.

License Agreement

SIMMS Software Technical Support SIMMS Software Product and S ales Information
On-line Support Partal SalesEkesica

Maorth America +1 [B04) 504-7936  [English) Morth America +1 [B04) 504-7338  [English)
E-mail the SIMMS Technical Support T eam Reguest a SIMMS enhancement

Learn about the SIS Suppart Plans Your feedback about SIMMS software is welcome

of it, may result i severe civil and ciminal penalties, and will be progecuted to the

“Warning: This computer program is protected under copyright law and intermational
K‘@ treaties. Unauthorized reproduction and/or distribution of thiz program or any portion
maximum extent pozzible under the law.

Fomyk Computer Solutions Intemational, [nc. -~
End-User Licenze Agreement

Important: Koyl Computer Solutions [ntemational, Inc. [herein after referred to az "KC517) icenses the
enclozed Software to pou only upon the condition that you accept all of the terms contained in thiz End-User
Licenze Agreement [“thiz Agreement”). Pleaze read these terms carefully, because opening this package or
clicking on the " accept” button indicates your acceptance of them. [ you do not agree with these tems,
then you dao nat have a licenze to uze the Software.

Far the purpoze of purchasing products and/or services from KCS1, | agree and acknowledge that | have
read and fully understand the terms and conditions of this agreement; | also agree to be baund by the
fallawing terms atnd conditions:

1. Defintions. The following terms are defined as uzed in this Agreement:

[a] Distibutor- company from which your reseller has chosen to buy the Software. Distibutor iz an
independent party and iz not an agent of KCSI

(5]} Resellerthe compary from which you have purchaszed the software. Reseller iz an independent
party and iz not an agent of KCSI

[c] Developer-the company that developed thiz program, in this case Komyk Computer S olutions
International, Inc. or KOS

[d] M anufacturer-the company that manufactured this program and in this case means Komyk
Computer Solutions Intemational, Inc. or KCS1.

[e] K.CSI-Fomyk Computer Solutions Intemational, Inc..

1] Documentation-the specifications for the Program set forth in the help files of the Program and the
Release Motes accompanying the Program.

[al Program-the computer program recorded on the media accompanying this Agreement, together
with any update or modification ta such Program subsequently supplied to pou directly or indirectly.

k] Software-the computer software recorded on the media accompanying thiz Agreement, including
the Diacumnentation.

] Hardware-any non-eoftware or non-abor Merchandise with Documentation. v

Reqgistration

Activation Code Reqister
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Visual Import Manager

Kornyk Computer Solutions International, Inc.

KCSI 32827 Harwood Place, Abbotsford, BC V2S 7C1
) Tel: 604-504-7936 Fax: 604-504-7976

Website: www.kcsi.ca Email: sales@kcsi.ca

Important SIMMS Software Contact Information

Address 32827 Harwood Place
Abbotsford, BC V2S 7C1 Canada
Sales Phone 604-504-7936
e-mail sales@kornyk.com

Support  Phone 604-504-7936

e-mail support@kornyk.com
Fax 604-504-7976
Accounting Phone 604-504-7936

e-mail colleen@kornyk.com
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